Specifications subject to change without notice.
SAFETY PRECAUTIONS

(Be sure to read these instructions before using the product.)

Before using this product, read this manual and the relevant manuals introduced in this manual carefully and handle the product correctly with full attention to safety.

Note that these precautions apply only to this product.

In this manual, the safety instructions are ranked as “DANGER” and “CAUTION”.

! DANGER

Indicates that incorrect handling may cause hazardous conditions, resulting in death or severe injury.

? CAUTION

Indicates that incorrect handling may cause hazardous conditions, resulting in minor or moderate injury or property damage.

Note that failure to observe the ? CAUTION level instructions may also lead to serious results according to the circumstances.

Be sure to observe the instructions of both levels to ensure personal safety.

Please keep this manual in accessible place and be sure to forward it to the end user.

[DESIGN PRECAUTIONS]

! DANGER

- Output may remain ON or OFF due to failure of the GOT, communication board or cable. For the output signals that may cause a serious accident, create an external fail safe circuit. Faulty output or malfunctions may result in an accident.

- When a communication error (including cable disconnection) occurs during monitoring by GOT, communication between GOT and PLC will be interrupted and GOT operation will be disabled. In the case of bus connection: CPU goes down and GOT is disabled. In the system configuration including a GOT, an external circuit that controls the critical operation of the system such as an emergency stop switch needs to be included in case a communication failure with the GOT occurs. Faulty output or malfunctions may result in an accident.

? CAUTION

- Do not install the control or communication cables together with the main circuit or power cable or do not bring them close to each other. The distance of 100mm (3.9inch) or more should be ensured. Failure to do so may cause malfunctions due to noise.
### [INSTALLATION PRECAUTIONS]

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
</table>
| ● Be sure to shut off all phases of the external power supply before installing or removing GOT to/from the panel.  
   Failure to do so may cause failure or malfunctions of the module. |
| ● Be sure to shut off all phases of the external power supply before installing or removing the communication board to/from GOT.  
   Failure to do so may cause failure or malfunctions of the module. |

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
</table>
| ● Use the GOT in the environment specified in the user’s manual of the GOT.  
   Failure to do so may cause electric shock, fire, malfunctions or product deterioration or damage. |
| ● Tighten the mounting screws within the specified torque range when installing the GOT to the panel.  
   Loose tightening may cause a fall, short circuits or malfunctions.  
   Overtightening may damage the screws and/or the module, resulting in a fall of the module, short circuits or malfunctions. |
| ● Tighten the mounting screws within the specified torque range when installing the communication board to the GOT.  
   Loose tightening may cause a fall, failure or malfunctions.  
   Overtightening may damage the screws and/or the module, resulting in a fall of the module, failure or malfunctions. |

### [WIRING PRECAUTIONS]

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
</table>
| ● Be sure to shut off all phases of the external power supply before wiring.  
   Failure to do so may cause electric shock, product damage or malfunctions. |
CAUTION

- Always ground the FG, LG and protective ground terminals of the GOT power supply area to the protective ground conductor. Failure to do so may cause electric shock or malfunctions.
- Confirm the rated voltage and terminal layout and connect the GOT to the power module correctly. Connecting to a power supply with incorrect rated voltage or faulty wiring may cause a fire or failure.
- Tighten the terminal screws of the GOT power supply area within the specified torque range. Loose tightening may cause short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in short circuits or malfunctions.
- Be careful not to let foreign matter such as dust or wire chips get inside the module. This may cause a fire, failure or malfunctions.
- For the bus connection cable, insert it to the connector of the module until a click sound can be heard. Make sure of proper connection after installation. Improper connection may cause malfunctions.
- For the communication cable, install it to the connector of the module and tighten the mounting screws or terminal screws within the specified range. Loose tightening may cause short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in short circuits or malfunctions.

TESTING PRECAUTIONS

DANGER

- When testing the operation of the user-created monitor screen (e.g. bit device ON/OFF or change of the word device current value, the timer/counter current or set value, the buffer memory current value), thoroughly read the relevant manual to fully understand the operating procedures. In the test operation, never change the data of the device which operation is critical to the system. Doing so may cause an accident due to faulty output or malfunctions.
### [START-UP/MAINTENANCE PRECAUTIONS]

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not touch any terminal while the module is energized. Doing so may cause electric shock or malfunctions.</td>
</tr>
<tr>
<td>Be sure to shut off all phases of the external power supply before cleaning or retightening the terminal screws. Failure to do so may cause failure or malfunctions of the module. Loose tightening may cause short circuits or malfunctions. Overtightening may damage the screws and/or the module, resulting in short circuits or malfunctions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not disassemble or remodel the module. Doing so may result in failure, malfunction, personal injury or a fire.</td>
</tr>
<tr>
<td>Do not directly touch a conducting part or electronic parts of the module. Doing so may cause malfunctions or failure of the module.</td>
</tr>
<tr>
<td>Be sure to secure communication cables and power cables connected to the module by ducts or clamps. Failure to do so may cause damage of the module or the cables due to accidental pull of dangling cables, or malfunctions due to poor cable connection.</td>
</tr>
<tr>
<td>Do not hold the communication cable part by hand when pulling it out from the module. Pulling the cable connected to the module may cause damage to the module or cable, or malfunctions due to poor cable connection.</td>
</tr>
<tr>
<td>Always make sure to touch the grounded metal to discharge the electricity charged in the body, etc., before touching the module. Failure to do so may cause a failure or malfunctions of the module.</td>
</tr>
</tbody>
</table>

### [DISPOSAL PRECAUTIONS]

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>When disposing the product, treat it as an industrial waste.</td>
</tr>
</tbody>
</table>
Cautions for using this software

1. Required PC memory
   The processing may be terminated by Windows® on a personal computer of which main memory capacity is less than 64M bytes. Make sure to secure the capacity of 64 M bytes or more.

2. Free capacity of hard disk (virtual memory)
   At least 50M bytes of free capacity of virtual memory should be secured within hard disk to run this software. The processing may be terminated by Windows® if 50M bytes or more of free space cannot be secured within hard disk while running GT Designer2.
   Secure enough free capacity of virtual memory within hard disk space in order to run the software.
   When enough free capacity cannot be secured, make sure to save projects frequently.

3. Error messages displayed while starting and editing
   “Operation will be terminated because of insufficient memory. Would you like to stop?”
   If the above message appears, close other running application software or reboot Windows® in order to secure at least 50M bytes of free hard disk space.

4. GT Designer2 and GOT display
   (a) Cautions for displaying straight line other than full line (dotted line, for example) in Bold
      When straight line other than full line is drawn in bold, the line may not be displayed with its actual line width on a personal computer.
      However, it will be displayed correctly on GOT. This phenomenon does not mean data problem.
   (b) Display of end points of straight line/line freeform/polygon
      As shown below, the end points of straight line/line freeform/polygon are displayed differently between GT Designer2 and GOT.
      ![On GT Designer 2](image)
      ![On GOT](image)
   (c) Start position for filling patterns
      Some filling patterns may be differently displayed.
      For example, the start position may be different between GT Designer2 and GOT.
   (d) Drawing of different type lines
      The length of the dots varies in different dotted lines (for example: the chain lines).
   (e) Display of object
      The display position of the memory data display in graph function is different between GT Designer2 and GOT.
      Even if the display-start-line of a comment has been set, the comment will be displayed from the first line on GT Designer2.
   (f) Display magnification
      When display magnification is changed, the connected lines or figures may be separated or the filled-paint may be out of outline of the figure.
      However, if they are displayed correctly on the preview screen, they will appear correctly on GOT as well.
      (Example): When filled-paint is out of the outline.
      ![Display magnification: 200%](image)
      ![Display magnification: 100%](image)
      Position of Paint mark may be shifted and the filled-paint may be out of the figure outline.
5. Restrictions when the color setting is changed to the setting of less colors in the system environment (256 colors → 2 colors)
The color palette for setting color will be changed according to the updated settings. The color on the drawing screen will be kept the same as prior to the change. If the color setting for a [red] rectangle-figure is changed to the 2 colors (B/W), the [red] color will remain. The colors of the image data (for example: BMP files) will be reduced when the project is saved.

6. Object function and device type
The object (bit lamp or word lamp), for which bit device setting and word device setting are separated, cannot be converted between bit device and word device.

7. When device type is changed
Confirm the device type when the set bit device is changed from bit device into word device. The device flag may be represented as "??", depending on the settings.
(Example) D0. b0 → D0 D0.b5 → ??

8. OS setting
Set the font size as “Small Font” when setting OS (Windows®) screen. The GT designer2 dialog box cannot be displayed correctly if the font size is set as “Large font”.

9. When the toolbar icon appears in smaller size after startup of GT Desinger2
The toolbar icon may appear in smaller size right after GT Desiger2 is started up. To correctly display the icon, initialize it as instructed below.
(Click on [Project] → [References] from the menu, and select the toolbar tab. Click on [Reset All] button in that tab.)

10. When using GT Designer2 in the PC in which the OS other than Japanese version
The text may not be displayed correctly depending on the OS versions; some version include the fonts incompatible with GT Designer2 or GOT.
<table>
<thead>
<tr>
<th>Print Date</th>
<th>Manual Number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr., 2003</td>
<td>SH (NA)-080250-A</td>
<td>First edition</td>
</tr>
<tr>
<td>Aug., 2003</td>
<td>SH (NA)-080250-B</td>
<td><strong>Partial corrections</strong>&lt;br&gt;Chapter 5</td>
</tr>
<tr>
<td>Jan., 2004</td>
<td>SH (NA)-080250-C</td>
<td><strong>Partial corrections</strong>&lt;br&gt;Section 3.2, Section 4.4, Section 7.2.1, Section 7.4.2, Section 7.4.3, Section 7.4.4</td>
</tr>
<tr>
<td>Sep., 2004</td>
<td>SH (NA)-080250-D</td>
<td><strong>Partial corrections</strong>&lt;br&gt;SAFETY PRECAUTIONS, Manuals, WARRANTY&lt;br&gt;<strong>MODEL CODE change</strong>&lt;br&gt;Change from 13JU25 to 1DM203</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 2003 MITSUBISHI ELECTRIC CORPORATION
SOFTWARE USER REGISTRATION

After agreeing to the terms of the Software License Agreement included in the package, please access the MELFANSweb Home Page (http://www.MitsubishiElectric.co.jp/melfansweb) and make a software user registration. (User registration is free of charge.)

(1) Software Registration

You can make a software registration by accessing the MELFANSweb Home Page or faxing or mailing the "Software Registration Card" packed with the product.
After you have made a software registration, we will register the user and send the "Software registration confirmation" together with the user ID.
We will also provide the latest information, such as the new product release, version upgrade information and event information, by direct mail.

(2) Notes on Contact

Please ask questions concretely and clearly using terms listed in the manual.
When requesting us to solve a problem, provide us with detailed information for reproducing the problem.
In addition, contact the respective manufacturers when asking questions about the operating system (OS) or the other vendor's software products

User registration is valid only in Japan.
## Manual Configuration

The following explains the manual configuration:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Overview</td>
<td>Provides the overview of this manual.</td>
</tr>
<tr>
<td>2</td>
<td>Software Package Configuration</td>
<td>Describes the software and data contained in the product.</td>
</tr>
<tr>
<td>3</td>
<td>System Configuration</td>
<td>Explains the system configuration of the product.</td>
</tr>
<tr>
<td>4</td>
<td>Installation and Uninstallation</td>
<td>Describes the installation, uninstallation and start of the product.</td>
</tr>
<tr>
<td>5</td>
<td>How to Use The Online Manual</td>
<td>Describes how to use the online manual.</td>
</tr>
<tr>
<td>6</td>
<td>What is The GOT?</td>
<td>Describes what the GOT is.</td>
</tr>
<tr>
<td>7</td>
<td>Creating The Monitor Data</td>
<td>Describes the procedure to create simple monitor data actually.</td>
</tr>
<tr>
<td>8</td>
<td>Executing Monitor ON The GOT</td>
<td>Describes the monitoring method with the GOT using the monitor screen data created in Chapter 7.</td>
</tr>
</tbody>
</table>
### INTRODUCTION

Thank you for choosing Mitsubishi Graphic Operation Terminal (Mitsubishi GOT). Read this manual and make sure you understand the functions and performance of the GOT thoroughly in advance to ensure correct use.

### CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAFETY PRECAUTIONS</td>
<td>A- 1</td>
</tr>
<tr>
<td>Cautions for using this software</td>
<td>A- 5</td>
</tr>
<tr>
<td>REVISIONS</td>
<td>A- 7</td>
</tr>
<tr>
<td>SOFTWARE USER REGISTRATION</td>
<td>A- 8</td>
</tr>
<tr>
<td>Manual Configuration</td>
<td>A- 9</td>
</tr>
<tr>
<td>INTRODUCTION</td>
<td>A-10</td>
</tr>
<tr>
<td>CONTENTS</td>
<td>A-10</td>
</tr>
<tr>
<td>Function Quick Reference</td>
<td>A-12</td>
</tr>
<tr>
<td>Manuals</td>
<td>A-19</td>
</tr>
<tr>
<td>Abbreviations and Generic Terms in This Manual</td>
<td>A-20</td>
</tr>
<tr>
<td>How to Use This Manual</td>
<td>A-23</td>
</tr>
<tr>
<td>Product List</td>
<td>A-24</td>
</tr>
</tbody>
</table>

### Start up

#### 1. OVERVIEW

1-1 to 1-2

1.1 When Conventional Software Is Used 1-1

1.2 About Manuals 1-2

#### 2. SOFTWARE PACKAGE CONFIGURATION

2-1 to 2-2

2.1 Software Types 2-1

2.2 Other Supplied Data 2-2

#### 3. SYSTEM CONFIGURATION

3-1 to 3-6

3.1 System Configuration 3-1

3.2 Operating Environment 3-1

#### 4. INSTALLATION AND UNINSTALLATION

4-1 to 4-9

4.1 Starting the Menu Screen 4-1
4.2 Installing the Software ................................................................. 4-2
  4.2.1 Installing GT Designer2, GT Simulator2 and/or GT SoftGOT2 ......................... 4-2
  4.2.2 Installing GT Converter ........................................................................ 4-5
  4.2.3 Installing Acrobat Reader ...................................................................... 4-6

4.3 Uninstalling the Software ............................................................. 4-7

4.4 Starting the Software ..................................................................... 4-9

5. HOW TO USE THE ONLINE MANUAL ................................................. 5-1 to 5-2

6. WHAT IS THE GOT? ........................................................................... 6-1 to 6-3
  6.1 About the GOT .................................................................................. 6-1
  6.2 About GOT Operation ....................................................................... 6-2

7. CREATING THE MONITOR DATA ......................................................... 7-1 to 7-22
  7.1 Setting before Screen Creation .......................................................... 7-1
  7.2 Creating Screens ............................................................................... 7-3
    7.2.1 Screen configuration of GT Designer2 ............................................. 7-3
    7.2.2 Creating the second screen .............................................................. 7-4
    7.2.3 Setting the screen switching device .................................................. 7-4
    7.2.4 How to switch between the created screens ..................................... 7-5
  7.3 Drawing Figures and Inputting Texts .................................................. 7-6
  7.4 Setting the Object Function .............................................................. 7-8
    7.4.1 Numerical display/numerical input setting method .................................. 7-9
    7.4.2 Lamp setting method ...................................................................... 7-11
    7.4.3 Touch switch (bit switch) setting method ........................................... 7-13
    7.4.4 Touch switch (Goto Screen switch) setting method ............................. 7-16
    7.4.5 Alarm List (System Alarm) setting method ........................................ 7-18
    7.4.6 Alarm List (User Alarm) setting method ............................................ 7-19
  7.5 Saving the Created Monitor Data ...................................................... 7-22

8. EXECUTING MONITOR ON THE GOT ................................................ 8-1 to 8-9
  8.1 Transferring Monitor Data from Personal Computer to GOT ..................... 8-1
    8.1.1 Connecting the personal computer and GOT ...................................... 8-1
    8.1.2 Installing the OS and communication driver ...................................... 8-2
    8.1.3 Downloading the monitor data ......................................................... 8-3
  8.2 Connecting with the PLC CPU .......................................................... 8-4
  8.3 Uploading ......................................................................................... 8-8
# Function Quick Reference

## Edit Operation (GT Designer2 Version1 Operating Manual)

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Align" /></td>
<td>Aligns objects or images</td>
<td>Page 8-18</td>
</tr>
<tr>
<td><img src="image" alt="Property sheet" /></td>
<td>Sets same attributes to objects or images in the same screen</td>
<td>Page 9-1</td>
</tr>
<tr>
<td><img src="image" alt="Replace colors" /></td>
<td>Changes the color(s) of the objects and figures arranged on plural screens at the same time</td>
<td>Page 9-10</td>
</tr>
<tr>
<td><img src="image" alt="Replace shapes" /></td>
<td>Changes the switch/lamp figures at the same time</td>
<td>Page 9-10</td>
</tr>
<tr>
<td><img src="image" alt="Replace devices" /></td>
<td>Changes the preset devices at the same time</td>
<td>Page 9-10</td>
</tr>
<tr>
<td><img src="image" alt="Data View" /></td>
<td>Overlapping images or objects</td>
<td>Page 9-14</td>
</tr>
<tr>
<td><img src="image" alt="Device list" /></td>
<td>Display the set device in list</td>
<td>Page 9-15</td>
</tr>
<tr>
<td><img src="image" alt="Multiple language input" /></td>
<td>Input characters or comments in other language.</td>
<td>Page 9-21</td>
</tr>
<tr>
<td><img src="image" alt="Import BMP/DXF file" /></td>
<td>Imports BMP/DXF files</td>
<td>Page 8-10</td>
</tr>
<tr>
<td><img src="image" alt="Import Project" /></td>
<td>Utilizes other project data</td>
<td>Page 9-28</td>
</tr>
</tbody>
</table>
## Digit/Font Display

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Numerical Display" /></td>
<td>Displays device value in numerical value</td>
<td>Page 5-61</td>
</tr>
<tr>
<td><img src="image2.png" alt="Numerical Input" /></td>
<td>Write value on device</td>
<td>Page 5-61</td>
</tr>
<tr>
<td><img src="image3.png" alt="Data List" /></td>
<td>Display multiple device value in list</td>
<td>Page 5-85</td>
</tr>
<tr>
<td><img src="image4.png" alt="ASCII Display" /></td>
<td>Displays device value in text</td>
<td>Page 5-100</td>
</tr>
<tr>
<td><img src="image5.png" alt="ASCII Input" /></td>
<td>Inputs text code device</td>
<td>Page 5-100</td>
</tr>
<tr>
<td><img src="image6.png" alt="Clock Display" /></td>
<td>Displays hour/minutes, year/month/date</td>
<td>Page 5-112</td>
</tr>
<tr>
<td><img src="image7.png" alt="Comment Display" /></td>
<td>Displays command</td>
<td>Page 5-118</td>
</tr>
</tbody>
</table>

## Alarm

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image8.png" alt="Alarm List" /></td>
<td>Displays message at alarm occurrence</td>
<td>Page 5-137</td>
</tr>
<tr>
<td><img src="image9.png" alt="Alarm History Display" /></td>
<td>Displays alarm history</td>
<td>Page 5-160</td>
</tr>
<tr>
<td><img src="image10.png" alt="Alarm Flow" /></td>
<td>Displays alarm in floating</td>
<td>Page 5-186</td>
</tr>
</tbody>
</table>
### Animation

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Parts display" /></td>
<td>Display entered device</td>
<td>Page 5-191</td>
</tr>
<tr>
<td><img src="image2.png" alt="Parts movement display" /></td>
<td>Displays moving parts</td>
<td>Page 5-209</td>
</tr>
<tr>
<td><img src="image3.png" alt="Lamp display" /></td>
<td>Displays device value via lamp color changing</td>
<td>Page 5-238</td>
</tr>
<tr>
<td><img src="image4.png" alt="Panel meter display" /></td>
<td>Displays device data on panel meter</td>
<td>Page 5-252</td>
</tr>
<tr>
<td><img src="image5.png" alt="Level display" /></td>
<td>Displays device data in proportional level</td>
<td>Page 5-264</td>
</tr>
<tr>
<td><img src="image6.png" alt="Trend graph display" /></td>
<td>Displays device data in trend graph</td>
<td>Page 5-276</td>
</tr>
<tr>
<td><img src="image7.png" alt="Line graph display" /></td>
<td>Displays device data in line graph</td>
<td>Page 5-289</td>
</tr>
<tr>
<td><img src="image8.png" alt="Bar graph display" /></td>
<td>Displays device data in bar graph</td>
<td>Page 5-301</td>
</tr>
<tr>
<td><img src="image9.png" alt="Statistics graph display" /></td>
<td>Displays device data in statistics graph</td>
<td>Page 5-313</td>
</tr>
<tr>
<td><img src="image10.png" alt="Scatter graph display" /></td>
<td>Displays device data in scatter graph</td>
<td>Page 5-323</td>
</tr>
<tr>
<td><img src="image11.png" alt="Sampling" /></td>
<td>Collect the device value and edit collected data on PC</td>
<td>Page 5-341</td>
</tr>
</tbody>
</table>
### 4 Touch switch

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Bit switch" /></td>
<td>Touch it to switch device ON/OFF</td>
<td>Page 5-348</td>
</tr>
<tr>
<td><img src="image2" alt="Data write switch" /></td>
<td>Touch it to change bit device value</td>
<td>Page 5-364</td>
</tr>
<tr>
<td><img src="image3" alt="Extended function switch" /></td>
<td>Touch it to switch to the extended function screen</td>
<td>Page 5-369</td>
</tr>
<tr>
<td><img src="image4" alt="Screen switching switch" /></td>
<td>Touch it to switch between the base and window screen</td>
<td>Page 5-377</td>
</tr>
<tr>
<td><img src="image5" alt="Station No. switching switch" /></td>
<td>Touch it to switch the monitored PLC station No.</td>
<td>Page 5-387</td>
</tr>
<tr>
<td><img src="image6" alt="Key code switch" /></td>
<td>Used as the key for inputting numerical value/ASCII</td>
<td>Page 5-393</td>
</tr>
</tbody>
</table>

### 5 Trigger → action

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7" alt="Status observation function" /></td>
<td>Monitors status of device and write value to device or operates GOT when condition meets</td>
<td>Page 5-412</td>
</tr>
<tr>
<td><img src="image8" alt="Recipe function" /></td>
<td>Monitors status of device and write/read device data when condition meets</td>
<td>Page 5-421</td>
</tr>
<tr>
<td><img src="image9" alt="Time action function" /></td>
<td>Outputs the device writing and sound at specified time.</td>
<td>Page 5-430</td>
</tr>
</tbody>
</table>
## Auxiliary

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Test</strong></td>
<td>Changes device value via test window in monitor screen</td>
<td>Page 5-437</td>
</tr>
<tr>
<td><strong>Script</strong></td>
<td>Controls GOT display by scripts</td>
<td>Page 5-440</td>
</tr>
<tr>
<td><strong>Set overlay screen</strong></td>
<td>Set overlay screen from other screens</td>
<td>Page 5-451</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Restricts the password users</td>
<td>Page 5-52</td>
</tr>
<tr>
<td><strong>Offset</strong></td>
<td>Accumulates the offset device value in monitor device address and monitor.</td>
<td>Page 5-48</td>
</tr>
<tr>
<td><strong>Data operation</strong></td>
<td>Operates device values by expression and enables objects using the operated value</td>
<td>Page 5-41</td>
</tr>
</tbody>
</table>
## External input/output

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Collects numerical data when condition meets and prints the numerical data and corresponding code.</td>
<td>Page 5-459</td>
</tr>
<tr>
<td>Hardcopy</td>
<td>Outputs the GOT monitor screen to printer or PC card</td>
<td>Page 5-482</td>
</tr>
<tr>
<td>Operation panel</td>
<td>Uses operation panel to execute device writing</td>
<td>Page 5-488</td>
</tr>
<tr>
<td>Bar code</td>
<td>Writes data read by barcode reader to device</td>
<td>Page 5-496</td>
</tr>
<tr>
<td>Sound</td>
<td>Outputs sounds</td>
<td>Page 5-501</td>
</tr>
<tr>
<td>Video</td>
<td>Displays video</td>
<td>Page 5-505</td>
</tr>
<tr>
<td>RGB display</td>
<td>Displays PC screens</td>
<td>Page 5-523</td>
</tr>
</tbody>
</table>

## Data Transmission (GT Designer2 Version1 Operating Manual)

<table>
<thead>
<tr>
<th>Image</th>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>Transmits monitor screen data from PC to GOT</td>
<td>Page 5-1</td>
</tr>
<tr>
<td>Upload</td>
<td>Transmits monitor screen data from GOT to PC</td>
<td>Page 5-17</td>
</tr>
<tr>
<td>Image</td>
<td>Function</td>
<td>Page</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>------</td>
</tr>
<tr>
<td>Print screen</td>
<td>Print base/window/report screen</td>
<td>Page 6-1</td>
</tr>
<tr>
<td>Print screen list</td>
<td>Print base/window/report screen</td>
<td>Page 6-1</td>
</tr>
<tr>
<td>Print device list</td>
<td>Prints list of the device used</td>
<td>Page 6-1</td>
</tr>
</tbody>
</table>
Manuals

**Relevant Manual**

For relevant manual, refer to the PDF manual stored within the drawing software.
Abbreviations and Generic Terms in This Manual

Abbreviations and generic terms used in this manual are as follows:

### GOT

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A985GOT-V</td>
<td>A985GOT-TBA-V, A985GOT-TBD-V</td>
</tr>
<tr>
<td>A985GOT</td>
<td>A985GOT-TBA, A985GOT-TBD, A985GOT-TBA-EU</td>
</tr>
<tr>
<td>A975GOT</td>
<td>A975GOT-TBA-B, A975GOT-TBA-EU</td>
</tr>
<tr>
<td>A97GOT</td>
<td>A97GOT-TBA, A97GOT-TBD, A97GOT-TBA-EU, A97GOT-TBA-EU</td>
</tr>
<tr>
<td>A970GOT</td>
<td>A970GOT-TBA-B, A970GOT-TBA, A970GOT-LBA, A970GOT-LBD</td>
</tr>
<tr>
<td>A960GOT</td>
<td>A960GOT-EBA, A960GOT-EBD, A960GOT-EBA-EU</td>
</tr>
<tr>
<td>A956WGOT</td>
<td>A956WGOT-TBD</td>
</tr>
<tr>
<td>F940GOT</td>
<td>F940GOT-SWD, F940GOT-LWD, ET-940BH(L), ET-940PH(L)</td>
</tr>
<tr>
<td>F930GOT-K</td>
<td>F930GOT-BDD-K</td>
</tr>
<tr>
<td>F930GOT</td>
<td>F930GOT-BWD, F933GOT-BWD</td>
</tr>
<tr>
<td>F920GOT-K</td>
<td>F920GOT-BDD5-K, F920GOT-BDD-K</td>
</tr>
<tr>
<td>F940WGOT</td>
<td>F940WGOT-TWD</td>
</tr>
</tbody>
</table>

### Communication board/communication module

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication board</strong></td>
<td></td>
</tr>
<tr>
<td>Bus connection board</td>
<td>A9GT-QB2SS, A9GT-QB2SS, A9GT-QB2SS</td>
</tr>
<tr>
<td>Serial communication board</td>
<td>A9GT-RS2, A9GT-RS2, A9GT-50WRS2</td>
</tr>
<tr>
<td><strong>Communication module</strong></td>
<td></td>
</tr>
<tr>
<td>Bus connection module</td>
<td>A9GT-QB2SS2U, A9GT-QB2SS2U, A7GT-BUS2S</td>
</tr>
<tr>
<td>Data link module</td>
<td>A7GT-J71AP23, A7GT-J71AR23, A7GT-J71AT23B</td>
</tr>
<tr>
<td>Network module</td>
<td>A7GT-J71LP23, A7GT-J71BR13, A7GT-J71LP23, A7GT-J71BR13</td>
</tr>
<tr>
<td>CC-Link communication module</td>
<td>A8GT-J61BT13, A8GT-J61BT15</td>
</tr>
<tr>
<td>Ethernet communication module</td>
<td>A9GT-J71E71-T</td>
</tr>
</tbody>
</table>

Abbreviations and generic terms used in this manual are as follows:
## Option Module

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External I/O module A9GT-70KBF, A8GT-50KBF</td>
<td></td>
</tr>
<tr>
<td>Printer interface module A9GT-50PRF type</td>
<td></td>
</tr>
<tr>
<td>Memory card interface module A1SD59J-MIF</td>
<td></td>
</tr>
<tr>
<td>Video/RGB mixed input interface module A9GT-80V4R1</td>
<td></td>
</tr>
<tr>
<td>Video input interface module A9GT-80V4</td>
<td></td>
</tr>
<tr>
<td>RGB input interface module A9GT-80R1</td>
<td></td>
</tr>
</tbody>
</table>

## Option

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug stand A9GT-80STAND, A9GT-70STAND, A9GT-50WSTAND, A9GT-50STAND</td>
<td></td>
</tr>
<tr>
<td>Ten-key panel A8GT-TK</td>
<td></td>
</tr>
<tr>
<td>Bus connector conversion box A7GT-CNB</td>
<td></td>
</tr>
<tr>
<td>Bus distance connector box A9GT-QCNB</td>
<td></td>
</tr>
<tr>
<td>Attachment A77GT-96ATT, A85GT-95ATT, A87GT-96ATT, A9GT-97ATT</td>
<td></td>
</tr>
<tr>
<td>PC card (memory card) Abbreviations of PC card with JEIDA Ver4.2 (PCMCIA Ver2.1)</td>
<td></td>
</tr>
<tr>
<td>Flash PC card A9GTMEM-10MF, A9GTMEM-20MF, A9GTMEM-40MF</td>
<td></td>
</tr>
<tr>
<td>Compact Flash PC card Abbreviation of Compact FlashTM (Compact FlashTM produced by Sun Disk.)</td>
<td></td>
</tr>
<tr>
<td>Connector conversion box F9GT-HCNB</td>
<td></td>
</tr>
</tbody>
</table>

## Software

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GT Works2 Version1</td>
<td>Abbreviation of SW1D5C-GTWK2-E</td>
</tr>
<tr>
<td>GT Designer2 Version1</td>
<td>Abbreviation of SW1D5C-GTD2-E</td>
</tr>
<tr>
<td>GT Designer2</td>
<td>Abbreviation of GOT900 series graphic software-GT Designer2</td>
</tr>
<tr>
<td>GT Simulator2</td>
<td>Abbreviation of GOT900 series screen simulator-GT Simulator2</td>
</tr>
<tr>
<td>GT SoftGOT2</td>
<td>Abbreviation of monitoring software-GT SoftGOT2</td>
</tr>
<tr>
<td>GT Converter</td>
<td>Abbreviation of GOT900 series data conversion software-GT Converter</td>
</tr>
<tr>
<td>GX Developer</td>
<td>Abbreviation of SWJ0D5C-GPWP(-)SWJ0D5F-GPWP(-) type software package</td>
</tr>
<tr>
<td>GX Simulator</td>
<td>Abbreviation of SWJ0D5C-LLT(-) type download test function software package (SW5D5C-LLT(-) or later)</td>
</tr>
</tbody>
</table>
### License (for GT SoftGOT, GT SoftGOT2)

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License</td>
<td>A9GTSOFT-LKEY-P (for DOS/VPC)</td>
</tr>
<tr>
<td>License FD</td>
<td>SW5DSF-SGLKEY-J (for PC CPU module)</td>
</tr>
</tbody>
</table>

### CPU

<table>
<thead>
<tr>
<th>Abbreviations and generic terms</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QCPU (Q Mode)</td>
<td>Q00CPU, Q02CPU, Q06CPU, Q12CPU, Q25CPU</td>
</tr>
<tr>
<td>QCPU (A Mode)</td>
<td>Q02CPU-A, Q02CPU-A, Q06CPU-A</td>
</tr>
<tr>
<td>QnACPU type</td>
<td>Q2ACPU, Q2ACPU-S1, Q2ACPU, Q2ACPU-S1</td>
</tr>
<tr>
<td>QnASCPU type</td>
<td>Q2ASCPU, Q2ASCPU-S1, Q2ASHCPU, Q2ASHCPU-S1</td>
</tr>
<tr>
<td>AnUCPU</td>
<td>A2UCPU, A2UCPU-S1, A3UCPU, A4UCPU</td>
</tr>
<tr>
<td>AnACPU</td>
<td>A2ACPU, A2ACPU-S1, A3ACPU</td>
</tr>
<tr>
<td>AnNCPU</td>
<td>A1NCPU, A2NCPU, A2NCPUS1, A3NCPU</td>
</tr>
<tr>
<td>AnCPU type</td>
<td>AnUCPU, AnACPU, AnNCPU</td>
</tr>
<tr>
<td>AnUS(H)CPU</td>
<td>A2USCPU, A2USCPU-S1, A2USCPU-S1, A3USCPU</td>
</tr>
<tr>
<td>AnS(H)CPU</td>
<td>A1SCPU, A1SHCPU, A2SCPU, A2SHCPU, A2SCPU-S1, A2SHCPU-S1</td>
</tr>
<tr>
<td>A1SJ(H)CPU</td>
<td>A1SJCPU, A1SJCPU-S1, A1SJCPU-S1, A1SJCPU-S1</td>
</tr>
<tr>
<td>AnSCPU type</td>
<td>AnUS(H)CPU, AnS(H)CPU, A1SJ(H)CPU</td>
</tr>
<tr>
<td>A1FXCPU</td>
<td>A1FXCPU</td>
</tr>
<tr>
<td>FXCPU</td>
<td>FX0 series, FX1N series, FX2C series, FX(2N)-10GM/20GM series</td>
</tr>
<tr>
<td>Motion controller CPU (Q series)</td>
<td>Q172CPU, Q173CPU, Q172CPUS1, Q173CPUS1</td>
</tr>
<tr>
<td>FA controller</td>
<td>LM610, LM7600, LM8000</td>
</tr>
<tr>
<td>MELDAS C6/C64</td>
<td>FCA C6, FCA C64</td>
</tr>
</tbody>
</table>
How to Use This Manual

Specification of symbols used in this manual

4.4 Starting the Software

Point
(1) When GT SoftGOT2 has been installed in the PC CPU module
When GT SoftGOT2 installed in the PC CPU module is used, a license must be
registered to the PC CPU module using the license key FD.
Refer to the following manual for the license key FD registration method.
GT SoftGOT2 Version1 Operating Manual

(2) Precautions for starting Acrobat Reader
The Software License Agreement is displayed when an attempt is made to start
Acrobat Reader after installing it.
Read this Software License Agreement carefully and select “Accept” to view the
PDF data, such as the online manual.
Acrobat Reader will not start if an attempt is made to view the PDF data before
selecting “Accept”.
In this case, restarting the personal computer and selecting “Accept” in the above
method allows Acrobat Reader to be used.

Point
Refers to information required for operation.

Hint
Refers to information useful for operation.

Remark
Refers to supplementary explanations

Shows the items including detailed explanation
(manual and the chapter, section, item).

1 → 2 → 3 → …
Indicates the operation steps.

Brackets used for the menu and items differ.

[ ] : Refers to menu in menu bar
Refers to dialog box item or GOT
utility menu

: Refers to dialog box buttons or PC
keyboard.
Product List

The following shows the product list of GT Works2 or GT Designer2.

- SW1D5C-GTWK2-E
  or
- SW1D5C-GTD2-E

About installation method of GT Works2/GT Designer2
End-user software license agreement
Software registration form
License agreement

NOTICES

- We don't guarantee the commercially-available Microsoft® Windows® Operating System-based software products that have been introduced in this manual.
- We hold the copyrights of this software package.
- No part of this manual may be transcribed or duplicated in any form without prior permission by Mitsubishi Electric Corporation.
- We have attempted to cover all the revisions of software and hardware, but this manual may not contain the latest revisions.
- The software of this product requires one license to be purchased per computer.
- We permit the user to use this software package (including this manual) based on the Software License Agreement.
- We are not liable for consequences or influences due to this software package (including this manual).
- The specifications of this software package and the descriptions in this manual may be altered in future without prior notice.
1. OVERVIEW

This manual explains the system configuration, installation method and PDF manual viewing method of the GOT900 series drawing software package (GT Works2 Version1, GT Designer2 Version1).

In and after Chapter 7 of this manual, an example of creating simple screens using GT Designer2 will be explained.

For those who uses the GOT for the first time, it is recommended to operate the GOT and GT Designer2 actually in the procedures given in and after Chapter 7 to learn the operation method.

**Remark**

About the data created in and after Chapter 7

The monitor data and sequence program created in and after Chapter 7 of this manual are packed with GT Designer2.

Use them as necessary for confirming the set data, etc.

1.1 When Conventional Software Is Used

GT Works2 Version1 and/or GT Designer2 Version1 may not be installed when the conventional GOT900 series software has been installed in the personal computer.

The following describes whether each software can be installed or not when the conventional software has been installed.

1. **GT Designer**

   If GT Designer has been installed in the personal computer, GT Designer2 can be installed.

2. **GT Simulator, GT SoftGOT**

   If GT Simulator or GT SoftGOT has been installed in the personal computer, GT Simulator2 or GT SoftGOT2 cannot be installed. Before installing GT Simulator2 or GT SoftGOT2, uninstall GT Simulator or GT SoftGOT.

3. **GT Converter**

   GT Works2 Version1 and GT Designer2 Version1 store latest GT Converter.

   When using GT Converter, it is recommended to use GT Converter that is stored in GT Works2 Version1 or GT Designer2 Version1.

   If GT Converter of GT Designer has been installed in the personal computer, GT Works2 Version1 or GT Designer2 Version1 can be installed.
1.2 About Manuals

Including this manual, there are three different manuals that are related to GT Designer2. Refer to the corresponding manual according to the purpose of use. The following manuals are stored in the product in a PDF format.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the product into the personal computer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a project</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create screens</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw figures</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make common settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange/set objects</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer data to the GOT</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Startup•Introductory Manual**
  Describes the installation method of the product. Also gives an example of creating simple screens and using them on the GOT.

- **Reference Manual**
  Describes the object, figure and screen specifications, object setting methods, etc.

- **Operating Manual**
  Describes the GT Designer2 screen configuration, screen customizing method, and project creation and data transfer methods.
# 2. SOFTWARE PACKAGE CONFIGURATION

This chapter explains the software and data stored in the CD-ROMs of GT Works2 Version1 and GT Designer2 Version1.

## 2.1 Software Types

GT Works2 Version1 and GT Designer2 Version1 store the following software programs. The stored software programs differ between GT Works2 Version1 and GT Designer2 Version1.

<table>
<thead>
<tr>
<th>Software Name</th>
<th>Description</th>
<th>GT Works2</th>
<th>GT Designer2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GOT900 series software</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GT Designer2</td>
<td>Software used to create screens for the GOT900 series.</td>
<td><strong>○</strong></td>
<td><strong>○</strong></td>
</tr>
<tr>
<td>GT SoftGOT2</td>
<td>Software that allows a personal computer to be used as the GOT. The license key or license key FD is required to use this software. (Without the license key or license key FD, this software operates for about 10 minutes.) When the license key or license key FD is necessary, contact the local Mitsubishi service center or representative.</td>
<td><strong>○</strong></td>
<td><strong>○</strong></td>
</tr>
<tr>
<td>GT Simulator2</td>
<td>Software that allows the GOT operation to be simulated on a personal computer connected with GX Simulator or PLC CPU.</td>
<td><strong>○</strong></td>
<td><strong>–</strong></td>
</tr>
<tr>
<td>GT Converter</td>
<td>Software that converts the monitor screen data for GOT800 series or Digital's package data into a GT designer format file.</td>
<td><strong>○</strong></td>
<td><strong>○</strong></td>
</tr>
<tr>
<td><strong>PDF viewing software</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe Acrobat Reader</td>
<td>Adobe Acrobat Reader (hereafter abbreviated to Acrobat Reader) is Adobe System's product. Acrobat Reader is the software that enables PDF data to be viewed. Since the online manual is written as PDF data, use this software to view.</td>
<td><strong>○</strong></td>
<td><strong>○</strong></td>
</tr>
</tbody>
</table>
2.2 Other Supplied Data

GT Works2 Version1 and GT Designer2 Version1 store the following data, in addition to the software given in Section 2.1.

The following data are loaded into the personal computer at installation of GT Designer2.

<table>
<thead>
<tr>
<th>Data Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online manual</td>
<td>Online manual related to the GOT900 series. Contained as PDF data.</td>
</tr>
<tr>
<td>Function-by-function sample data for A975GOT</td>
<td>Function-by-function sample screen data for the A975GOT. To operate a sample screen actually, write the sequence program contained in the &quot;Ladder&quot; folder to the PLC CPU using GX Developer, etc.</td>
</tr>
<tr>
<td>Sample data for F940GOT/F940WGOT</td>
<td>Sample screen data for the F940GOT/F940WGOT.</td>
</tr>
<tr>
<td>Sample data for microcomputer connection</td>
<td>Sample screen data and sample program (C language) for microcomputer connection.</td>
</tr>
<tr>
<td>Introductory Manual data</td>
<td>Screen data explained in and after Chapter 7 of this manual. To operate screen data actually, write the sequence program contained in the &quot;Ladder&quot; folder to the PLC CPU using GX Developer, etc.</td>
</tr>
<tr>
<td>256-color test data</td>
<td>Screen data where the color patterns of 256 colors have been set and with which the display of 256 colors can be confirmed.</td>
</tr>
</tbody>
</table>

After GT Designer2 is installed, data are stored into the following folders.

MELSEC—GTD2

Example

```
- 256test ................................................ (256-color test screen data)
- A975got ................................................ (Function-based sample screen data for A975GOT)
  - 00 Example
  - 01 Touchswitch+Lamp
  - 02 Data input+Data display
  - 03 Part display+Part movement
  - 04 Multiple language
  - 05 Message display
  - 06 Alarm history-Sound
  - 07 Recipe+Security
  - 08 Graph display
  - 09 Script
  Ladder
- Introduction ......................................... (Introductory Manual screen data)
  Ladder
- Manual .................................................. (Online manual)
- OS ....................................................... (OS for GOT unit) *
- Gmdp .................................................... (Special data) *
```

* Do not delete the folders and do not tamper with the data in the folders.
3. SYSTEM CONFIGURATION

3.1 System Configuration

The system configuration is shown below.

![System Configuration Diagram]

IBM-PC/AT-compatible personal computer

GT Works 2 Version 1 or
GT Designer 2 Version 1

3.2 Operating Environment

The following tables indicate the operating environment of the GOT900 series software stored in GT Works2 Version1 and GT Designer2 Version1.

### GT Designer2

The following table indicates the operating environment of GT Designer2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>Personal computer on which Windows® operates.</td>
</tr>
<tr>
<td>OS</td>
<td>Microsoft® Windows® 98 operating system</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition operating system *1</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® NT® Workstation4.0 operating system *1</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional operating system *1</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Professional operating system *1 *2</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Home Edition operating system *1 *2</td>
</tr>
<tr>
<td>Computer main unit</td>
<td>Refer to &quot;Used Operating System and performance required for personal computer main unit&quot; on the next page.</td>
</tr>
<tr>
<td>CPU</td>
<td>Required memory</td>
</tr>
<tr>
<td></td>
<td>At installation: 250M bytes or more</td>
</tr>
<tr>
<td></td>
<td>At execution : 50M bytes or more</td>
</tr>
<tr>
<td>Disk drive</td>
<td>CD-ROM disk drive</td>
</tr>
<tr>
<td>Display color</td>
<td>256 colors</td>
</tr>
<tr>
<td>Display</td>
<td>Resolution 800  ×  600 dots or more</td>
</tr>
<tr>
<td>Others</td>
<td>Internet Explorer Ver. 5.0 or later must be installed.</td>
</tr>
</tbody>
</table>

*1 The authority of the administrator is required when installing GT Designer2 into Windows NT®, Workstation4.0, Windows®, 2000 Professional, Windows® XP Professional or Windows® XP Home Edition; when using GT Designer2 on Windows® XP Professional or Windows® XP Home Edition.

*2 "Compatibility mode", "user's easy switching" and "desktop theme (font) change" are not supported.
### Basic software used and PC performance required

<table>
<thead>
<tr>
<th>Basic software</th>
<th>Required PC performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Required memory</td>
</tr>
<tr>
<td>Microsoft® Windows® 98 operating system</td>
<td>Pentium® 200 MHz or larger</td>
</tr>
<tr>
<td>Microsoft® Windows® Me operating system</td>
<td>Pentium® 200 MHz or larger</td>
</tr>
<tr>
<td>Microsoft® WindowsNT® Workstation4.0 operating system</td>
<td>Pentium® 200 MHz or larger</td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional operating system</td>
<td>Pentium® 200 MHz or larger</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional operating system</td>
<td>Pentium II® 300 MHz or larger</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Home Edition operating system</td>
<td>Pentium II® 300 MHz or larger</td>
</tr>
</tbody>
</table>
## GT Simulator2

The following table indicates the operating environment of GT Simulator2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>Personal computer on which Windows® operates.</td>
</tr>
<tr>
<td>OS</td>
<td>Microsoft® Windows® 98 operating system.</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition operating system.</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® NT® Workstation4.0 operating system.</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional operating system.</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Professional operating system.</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Home Edition operating system.</td>
</tr>
<tr>
<td>Computer main unit</td>
<td>Refer to &quot;Used Operating System and performance required for personal computer main unit&quot; on the next page.</td>
</tr>
<tr>
<td>CPU</td>
<td>Required memory</td>
</tr>
<tr>
<td>Free hard disk space</td>
<td>At installation: 200M bytes or more</td>
</tr>
<tr>
<td></td>
<td>At operation: 50M bytes or more</td>
</tr>
<tr>
<td>Disk drive</td>
<td>CD-ROM disk drive</td>
</tr>
<tr>
<td>Display color</td>
<td>256 colors</td>
</tr>
<tr>
<td>Display</td>
<td>Resolution 800 × 600 dots or more</td>
</tr>
<tr>
<td>Required software</td>
<td>Required</td>
</tr>
<tr>
<td></td>
<td>GT Designer or GT Designer2</td>
</tr>
<tr>
<td></td>
<td>When GX Simulator is used For QCPU (A mode), ACPU or motion controller CPU simulation: SW5D5C-LLT Version A or later</td>
</tr>
<tr>
<td></td>
<td>For QCPU (Q mode) (except Q00J/Q00/Q01CPU), QnACPU or FXCPU simulation: SW5D5C-LLT Version E or later</td>
</tr>
<tr>
<td></td>
<td>For Q00J/Q00/Q01CPU simulation: SW6D5C-LLT Version A or later</td>
</tr>
<tr>
<td></td>
<td>For Q12PHCPU or Q25PHCPU simulation: SW6D5C-LLT Version L or later</td>
</tr>
<tr>
<td>Valid OS</td>
<td>Japanese, English</td>
</tr>
</tbody>
</table>

*1 When GT Simulator2 is used with GX Developer or GX Simulator, more free space is necessary. For the free space necessary for use of GX Developer or GX Simulator, refer to the GX Developer or GX Simulator Operating Manual (Startup).

*2 When using GT Simulator2, use the personal computer where Windows NT® Workstation 4.0 of Service Pack 3 or later has been installed.

*3 Use GT Designer2 contained in GT Works2 that contains GT Simulator2.

*4 "Compatibility mode", "user's easy switching" and "desktop theme (font) change" are not supported.

*5 The authority of the administrator is required when installing GT Simulator2 into WindowsNT® Workstation4.0, Windows® 2000 Professional, Windows® XP Professional or Windows® XP Home Edition; when using GT Simulator2 on Windows® XP Professional or Windows® XP Home Edition.

*6 Characters in the dialog box may not be properly displayed when OS other than the above is used.
Basic software used and PC performance required

<table>
<thead>
<tr>
<th>Basic software</th>
<th>CPU</th>
<th>Required PC performance</th>
<th>Required memory</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Required memory</td>
<td>GT Simulator2 only</td>
<td>GT Simulator2 + GX Developer + GX Simulator</td>
</tr>
<tr>
<td>Microsoft® Windows® 98 operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>32MB or more (96MB or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® Me operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>32MB or more (96MB or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows NT® Workstation4.0 operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>32MB or more (96MB or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional operating system</td>
<td>Pentium® 200MHz or more (Pentium II® 300MHz or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
<td>64MB or more (96MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional operating system</td>
<td>Pentium II® 300MHz or more (Pentium II® 450MHz or more recommended)</td>
<td>128MB or more (192MB or more recommended)</td>
<td>128MB or more (192MB or more recommended)</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Home Edision operating system</td>
<td>Pentium II® 300MHz or more (Pentium II® 450MHz or more recommended)</td>
<td>128MB or more (192MB or more recommended)</td>
<td>128MB or more (192MB or more recommended)</td>
</tr>
</tbody>
</table>
## GT SoftGOT2

The following table indicates the operating environment of GT SoftGOT2.

<table>
<thead>
<tr>
<th>Item</th>
<th>When IBM-PC/AT-compatible Personal Computer Is Used</th>
<th>When PC CPU Module Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>Personal computer on which Windows® operates.</td>
<td>MELSEC-Q series compatible PC CPU module manufactured by CONTEC</td>
</tr>
<tr>
<td>OS</td>
<td>Microsoft® Windows® 98 operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® WindowsNT® Workstation 4.0 operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000 Professional operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Professional operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP Home Edition operating system</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>Refer to &quot;Used Operating System and performance required for personal computer main unit&quot; on the next page.</td>
<td></td>
</tr>
<tr>
<td>Required memory</td>
<td>64M bytes or more (96M bytes or more recommended)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(96M bytes or more (128M bytes or more recommended) when GT SoftGOT2 and GX Developer are used simultaneously or more than one GT SoftGOT2 are started.)</td>
<td></td>
</tr>
<tr>
<td>Free hard disk space</td>
<td>At installation: 200M bytes or more</td>
<td></td>
</tr>
<tr>
<td></td>
<td>At operation: 100M bytes or more ※3</td>
<td></td>
</tr>
<tr>
<td>Disk drive</td>
<td>CD-ROM disk drive</td>
<td>3.5 inch (1.44MB) floppy disk drive CD-ROM disk drive</td>
</tr>
<tr>
<td>Display color</td>
<td>256 colors</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Resolution 800 × 600 dots or more (640 × 480 dots or more when full screen display function is used)</td>
<td></td>
</tr>
<tr>
<td>Required software</td>
<td>GT Designer Version 5 Edition D or later or GT Designer2</td>
<td></td>
</tr>
<tr>
<td>Requirement license key/license key FD</td>
<td>A9GTSOFT-LKEY-P ※2</td>
<td>SW5D5F-SGLKEY-J</td>
</tr>
<tr>
<td>Valid OS</td>
<td>Japanese, English ※6</td>
<td></td>
</tr>
</tbody>
</table>

※1 Use the personal computer where Windows NT® Workstation 4.0 of Service Pack 3 or later has been installed.
※2 To use the A9GTSOFT-LKEY-P, a parallel port (Centronics/printer connector) is required for the IBM-PC/AT-compatible personal computer.
※3 When more than one GT SoftGOT2 are started, “number of started GT SoftGOT2’s × 100” M bytes are required. When the monitor screen data size (space) is large (30M bytes or more as a guideline), 200M bytes or more may be required.
※4 "Compatibility mode", "user's easy switching" and "desktop theme (font) change" are not supported.
※6 Characters in the dialog box may not be properly displayed when OS other than the above is used.
<table>
<thead>
<tr>
<th>Basic software used and PC performance required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic software</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Microsoft® Windows® 98 operating system</td>
</tr>
<tr>
<td>Microsoft® Windows® Me operating system</td>
</tr>
<tr>
<td>Microsoft® Windows NT® Workstation4.0 operating system</td>
</tr>
<tr>
<td>Microsoft® Windows® 2000 Professional operating system</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Professional operating system</td>
</tr>
<tr>
<td>Microsoft® Windows® XP Home Edition operating system</td>
</tr>
</tbody>
</table>
4. INSTALLATION AND UNINSTALLATION

This chapter explains the installation and uninstallation of the software programs stored in GT Works2/GT Designer2.

4.1 Starting the Menu Screen

1. Insert the CD-ROM into the CD-ROM drive of the personal computer where Windows® has started. The menu screen will soon start.

2. As the menu screen of GT Works2/GT Designer2 starts, install the corresponding software or view the PDF manual.

As this menu screen is displayed after completion of one process, another process can be executed without a break. When it is desired to end the menu screen, click the Exit button.

**Point**

If the menu screen does not start

Start the menu screen in the following procedure if it does not start automatically when the CD-ROM of GT Works2/GT Designer2 is inserted into the CD-ROM drive.

(1) Using Device Manager of Windows®, make setting to start the CD-ROM drive automatically.

(2) Start Explorer and double-click GTWK2-J.exe or GTD2-J.exe. of the CD-ROM drive.
4.2 Installing the Software

**Point** Precautions for installation

1. Before starting installation, close all other applications that being run on Windows®.

2. When using Windows NT®, Workstation 4.0, Windows® 2000, Windows® XP Professional or Windows® XP Home Edition, log on as a user who has the attributes of the administrator (for computer management).

3. During installation, do not install any other software.

4. During installation, do not remove the CD-ROM from the CD-ROM drive.

4.2.1 Installing GT Designer2, GT Simulator2 and/or GT SoftGOT2

**Point** Screens displayed midway during installation

To prepare for installation, any of the following screens may be displayed midway during installation.

If any of the following screens is displayed, reinstall the product after execution of the specified exe file according to the instruction of the screen.

When the product has not been installed correctly, restart the computer once.

If the screen on the right is displayed, execute \Update\ 50COMUPD.exe of the CD-ROM.

If the screen on the right is displayed, execute \Update\ Jaaxdist.exe of the CD-ROM.

If the screen on the right is displayed, execute \EnvMEL\ Setup.exe of the CD-ROM.
1 Click the software to be installed.

2 When "GT SoftGOT2 install" has been selected, the screen on the left is displayed.

   "GT SoftGOT2 install"
   GT SoftGOT2 will be installed.

   "System Driver"
   The system driver will be installed/uninstalled.
   When the PC CPU module is used, the system driver need not be installed.

   *Unless the system driver is installed, GT SoftGOT2 will not recognize the license key if the license key is mounted to the personal computer.

3 Input you name and any organization name, and click the Next button.
   As the confirmation dialog box is displayed, perform operation according to the message.

(To next page)
4 Input the product ID of the product and click the Next button. The product ID is indicated in the software registration form packed with the product.

5 Specify the installation destination folder. The installation destination folder defaults to "C:\MELSEC". When the default is acceptable, click the Next button. To change the default, click the Browse button and specify a new drive and folder.

6 Installation starts. When installation is completed, the screen on the left is displayed. Click the OK button.

7 If the screen on the left is displayed, Windows must be restarted.
When GT Designer2, GT SoftGOT2 and GT Simulator2 are installed, icons are registered as shown below.

### 4.2.2 Installing GT Converter

**Point**

Screens displayed midway during installation

Midway during installation, any of the screens shown in Section 4.2.1 may be displayed.

Section 4.2.1 Installing GT Designer2, GT Simulator2 and/or GT SoftGOT2

1. Start Explorer of Windows® and click the drive where the disk has been inserted.
2. Double-click Setup.exe in the GTconv folder.

For the steps hereafter, refer to the following.

and later in Section 4.2.1

When GT Converter is installed, an icon is registered as shown below.
4.2.3 Installing Acrobat Reader

Install Acrobat Reader to view the online manual.

1. Click "Acrobat Reader install" of Setup.

2. Perform installation operation according to the instructions of the Acrobat Reader installer.

3. When installation is completed, the screen on the left is displayed. Click the OK button.
4.3 Uninstalling the Software

**Point**

Precautions for uninstallation

1. Before starting uninstallation, always close the corresponding software package.
2. When using Windows NT® Workstation 4.0 or Windows® 2000, log on as a user who has the attributes of the administrator (for computer management).

1. Double-click the Add/Delete Programs icon in Control Panel.
2. Select the software to be uninstalled.

After selection, click the **Add/Remove** button.

(To next page)
3. Confirm the software to be deleted.

   Click the **Yes** button to start uninstallation.
   Click the **No** button to return to the previous screen without executing uninstallation.

*Components indicate the installed icon and files.

4. When the screen as on the left (the file name and location display may be different) is displayed, click the **No to All** button.

   *When the **Yes** or **Yes to All** button is clicked, the shared file of MELSOFT may be deleted and the other software packages may not operate.

5. When uninstallation is completed, the screen on the left is displayed. Click the **OK** button.
4.4 Starting the Software

**Point**

(1) When GT SoftGOT2 has been installed in the PC CPU module

When GT SoftGOT2 installed in the PC CPU module is used, a license must be registered to the PC CPU module using the license key FD. Refer to the following manual for the license key FD registration method.

[GT SoftGOT2 Version1 Operating Manual](#)

(2) Precautions for starting Acrobat Reader

The Software License Agreement is displayed when an attempt is made to start Acrobat Reader after installing it. Read this Software License Agreement carefully and select "Accept" to view the PDF data, such as the online manual. Acrobat Reader will not start if an attempt is made to view the PDF data before selecting "Accept". In this case, restarting the personal computer and selecting "Accept" in the above method allows Acrobat Reader to be used.

1. Click the menu of the software package to be started.
   - In the case of GT Designer2, GT SoftGOT2, GT Simulator2 or GT Converter
     Make selection from [Start] → [Programs] → [MELSOFT Application].
   - In the case of Acrobat Reader
     Make selection from [Start] → [Programs].

2. The corresponding software package starts.
5. HOW TO USE THE ONLINE MANUAL

The online manual is contained in the CD-ROM of the product in the form of PDF data. To view the PDF data, Acrobat Reader must have been installed in the personal computer. When Acrobat Reader has not been installed in the personal computer, refer to the following and install Acrobat Reader.

Section 4.2.3 Installing Acrobat Reader

The online manual can be viewed in the following procedure.

1. Click PDF Manual on the menu screen.

2. As the INDEX MENU screen is displayed, click the manual to be viewed.

(To next page)
Clicking the index item switches the manual display screen. Click "INDEX_MENU" to return to the INDEX_MENU screen (manual selection screen).
6. WHAT IS THE GOT?

6.1 About the GOT

1 What is the GOT?
The GOT (Graphic Operation Terminal Unit) can be used as an electronic operation panel on which functions such as switch operation, lamp display, data display, message display can be operated on the monitor screen, which had been conventionally implemented with a control box.

2 About monitor screen data to be displayed on GOT
Create the monitor screen data, which will be displayed on the GOT, using the dedicated software (GT Designer2) on the personal computer. On GT Designer2, paste display frame figures called objects, such as switch figures, lamp figures and numerical display, to create a screen, and set operation functions to the pasted objects with the device memory (bit, word) of the PLC CPU to execute the functions of the GOT. Transfer the created monitor screen data to the GOT via an RS-232C cable or PC card (memory card).
6.2 About GOT Operation

This section explains briefly what operation the GOT will perform when it is connected with the PLC CPU.

1 System example

![System example diagram]

<Settings of GOT for figures>
- Touch switch setting
  - Bit momentary
  - Write device: M0
- Touch switch setting
  - Bit momentary
  - Write device: M1
- Lamp display setting
  - Bit
  - Read device: Y10
- Numerical display
  - Read device: D10, unsigned BIN
  - Display: Unsigned decimal number

2 Operation explanation

1 While the touch switch "Operation" of the GOT is being touched, the bit device "M0" is ON.

![Operation explanation diagram]

2 When the bit device "M0" turns ON, the bit device "Y10" turns ON.

An ON figure is also displayed in the lamp of the GOT where the monitor device has been set to the bit device "Y10".
3. As the bit device "M0" is ON, "123" is stored into the word device "D10".

Also, "123" is displayed in the numerical display of the GOT where the monitor device has been set to the bit device "D10".

4. While the touch switch "Stop" of the GOT is being touched, the bit device "M1" of the PLC CPU is ON.

Since the OFF condition of the bit device "Y10" of the PLC CPU is met, the lamp of the GOT turns OFF.
7. CREATING THE MONITOR DATA

This and latter chapters explain how to create screens on GT Designer2 and operate them on the GOT. For those who will use the GOT for the first time or who want to know the specific operation examples of GT Designer2, it is recommended to refer to this and latter chapters and use the GOT and GT Designer2.

7.1 Setting before Screen Creation

Before creating a screen, set the GOT to be used, the type of the PLC CPU, and the title of the screen.

Starting GT Designer2 displays the screen on the left. As a new screen will be created this time, click the New button.

As the screen on the left (System Environment screen) is displayed, select the type of the GOT to be used and the type of the PLC (PLC Type). After making selection, click the OK button.

Set data
- GOT Type: A97 GOT/SoftGOT(640 × 480)
- PLC Type: MELSEC-QnA/Q
As the Screen Property dialog box is displayed, input the screen title.

Click the **OK** button to create Base Screen 1.
The screen will be created specifically hereafter.

**Set data**
Screen Name: Data Display Screen
7.2 Creating Screens

After making preparations for screen creation, create screens actually. In this manual, the following two screens will be created.

Base screen 1

Base screen 2

7.2.1 Screen configuration of GT Designer2

Before creating screens, the basic screen configuration of GT Designer2 will be explained.

Menu bar

Toolbar

Workspace

Property sheet

Data View

The settings of the whole project, such as the created screens and common settings, are displayed in a tree form. Setting, copy, etc. can be performed by double-click and right-click.

The selected screen/object/figure attributes are displayed. Setting can be also made here.

All object functions and figures set on the drawing are displayed in a list.
7.2.2 Creating the second screen

One screen has already been created in the previous section (Section 7.1 Setting before Screen Creation). Since two screens will be created in this manual, create the second screen first.

1. Right-click on the Base Screen on the tree in the project workspace and select [New].

2. As the Screen Property dialog box is displayed, input the screen title.

3. Click the OK button to create the second screen.

Set data
Screen Name: Error screen

7.2.3 Setting the screen switching device

1. What is screen switching device?

A screen switching device is a word device used to switch the screen on the GOT. The GOT switches to the screen of the numeric value stored in the screen switching device. Use the screen switching device for screen switching only.

When the value of the screen switching device is 1, the GOT displays Base screen 1.

When the value of the screen switching device turns from 1 to 2, the GOT displays Base screen 2.
2 Screen switching device setting method


2. As the System Environment dialog box is displayed, double-click [Screen Switching].

3. As the Screen Switching Device Settings dialog box is displayed, set [Base Screen Switching].

   Set data
   Base Screen Switching: D100

4. Clicking the OK button completes the setting of the screen switching device.

7.2.4 How to switch between the created screens

One created screen can be switched to the other by double-clicking either of the base screens on the tree in the project workspace.

Double-click the screen to be displayed.
7.3 Drawing Figures and Inputting Texts

First, draw frame lines and input texts to create the following screens. The methods are described below.

**Base screen 1**

**Frame line drawing method**

1. Click .

2. As the mouse cursor turns into +, press the left mouse button at the starting point for drawing a rectangular.

3. Drag and move the cursor to the end point.

4. Release the left mouse button to draw a rectangular.

(After arrangement, right-click the mouse to cancel the arrangement mode.)

5. As double-clicking the created rectangular displays the Setting dialog box, the color and thickness of the line can be changed.

6. Click the button to close the dialog box.

7. Repeat steps 1 to 6 to draw frame lines.

After selecting the drawn figure, holding down the Ctrl key and dragging the figure allows it to be copied easily.
2 Text input method

1. Click A.

2. As the mouse cursor turns into +, click the mouse in the position where a text will be entered. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As clicking the mouse displays the Text dialog box, input a text. The input result is immediately reflected on the screen.

4. Click the OK button to close the dialog box.

Hint!

Figure and text size changing method

After selecting the figure or text to be resized, drag the handle (■) to change the size.

Example: When resizing a rectangular

Drag.
7.4 Setting the Object Function

After drawing figures and texts, set their object functions.
This section explains the object function to be set in this manual.

Base screen 1

Numeric display
The value stored in the PLC CPU device is displayed.
(Section 7.4.1)

Lamp (Bit lamp)
The lamp is lit when the bit device of the PLC CPU turns ON.
(Section 7.4.2)

Alarm list display
(System Alarm)
The error that occurred in the GOT is displayed.
(Section 7.4.5)

Base screen 2

Alarm list display
(Use Alarm)
When the bit device turns ON, the corresponding comment preregistered by the user is displayed.
(Section 7.4.6)

Numeric input
The value is written to the PLC CPU device.
(Section 7.4.1)

Touch switch
(Bit switch)
Touching this switch turns OFF the bit device of the PLC CPU.
(Section 7.4.3)

Touch switch
(Goto Screen switch)
Touching this switch switches the screen.
(Section 7.4.4)
### 7.4.1 Numerical display/numerical input setting method

1. Click (Numerical Display) or (Numerical Input).

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the display or input. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged numerical display or numerical input displays the dialog box, make settings. (See below.)

   **Set data (Numerical Display)**
   - Type: Numerical Display
   - Device: D10
   - Shape: Frame_1

   **Set data (Numerical Input)**
   - Type: Numerical Input
   - Device: D11
   - Shape: Frame_1

4. After the setting is complete, click the **OK** button.

(To next page)
Drag. 

5 Change the size.

6 When the object is resized, the figure frame and object may be displaced. If the figure frame and object are displaced, select the object, then right-click the mouse, and select [Centering]. The displacement is automatically corrected.

When [Enable Two Tracker Mode] is selected, the figure frame and object can be moved individually by the user.

7 This completes the numerical display/input setting.

Objects set in this section
7.4.2 Lamp setting method

1. Click .

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the lamp. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged lamp displays the dialog box, make settings. (See below.)

   **Set data Basic tab**
   
   Device: M0

   **Set data Text tab**
   
   Text: M0

4. After Text tab setting, click the Copy OFF → ON button. (The Text tab data set at OFF is reflected at ON.)

   Click the button to confirm the ON-time attributes.

5. After the setting is complete, click the OK button.

6. This completes the setting of the first lamp.
When creating the second lamp or later, select the set lamp and then select the [Edit] → [Consecutive Copy] menu to display the Consecutive Copy dialog box.

Set data
Number X: 4
Interval X: 16

Click the OK button to copy the lamp.

Change the text of each lamp in the Property sheet.

This completes the lamp setting.

Objects set in this section
Base screen 1
Base screen 2
7.4.3 Touch switch (bit switch) setting method

1. Click ☑️ to select ☐️ (Bit Switch) in the sub menu.

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the touch switch. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged touch switch displays the dialog box, make settings. (See below.)

   **Set data Basic tab**
   - Device: M0
   - Action: Reset
   - Shape: rect_5

   **Set data Text/Lamp tab**
   - Text: M0

4. After setting, click the **Copy OFF → ON** button on the Text tab. (The Text tab data set at OFF is reflected at ON.)
   - Click the **ON** button to confirm the ON-time attributes.

5. After the setting is complete, click the **OK** button.
This completes the setting of the first touch switch.

When creating the second touch switch or later, select the touch switch and then select the [Edit] → [Consecutive Copy] menu to display the Consecutive Copy dialog box.

Set data
Number X: 4
Interval X: 16

Click the OK button to copy the touch switch.

Change the text of each touch switch in the Property sheet.

This completes the touch switch setting.
Objects set in this section

Base screen 1

Base screen 2
7.4.4 Touch switch (Goto Screen switch) setting method

1. Click \[\text{Goto Screen Switch}\] to select \[\text{Goto Screen Switch}\] in the sub menu.

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the touch switch. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. As double-clicking the arranged touch switch displays the dialog box, make settings. (See below.)

   **Set data Basic tab**
   - Goto screen: Fixed Screen (2)
   - Shape: rect_5

   **Set data Text/Lamp tab**
   - Text: Error screen

4. After setting, click the [Copy OFF → ON] button on the Text tab. (The Text tab data set at OFF is reflected at ON.)
   - Click the [ON] button to confirm the ON-time attributes.

5. After the setting is complete, click the [OK] button.

(To next page)
This completes the setting of the touch switch on Base screen 1. After setting, press the Ctrl key + C key with the touch switch selected. (Shortcut: Copy)

Double-click Base Screen 2 (Error screen) on the tree in the Project workspace to display Base screen 2.

Press the Ctrl key + V key on Base screen 2 to paste the copied touch switch. (Shortcut: Paste) Click the mouse to paste the touch switch.

Select the pasted switch, and change the set data in the Property sheet.

Set data
Fixed value : 2 → 1
Text : Error screen → Data display
This completes the Goto Screen switch setting.

Objects set in this section

7.4.5 Alarm List (System Alarm) setting method

1. Click 

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the alarm list. (After arrangement, right-click the mouse to cancel the arrangement mode.)

3. Adjust the size.

4. This completes the setting of the alarm list (system alarm).

Object set in this section
7.4.6 Alarm List (User Alarm) setting method

To use the Alarm List (User Alarm), the comments to be displayed as alarms must be registered beforehand.

1 Comment registering method

In this manual, the following comments will be registered.

<table>
<thead>
<tr>
<th>Comment No</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A-line supply conveyer stopped. Check the power source.</td>
</tr>
<tr>
<td>2</td>
<td>Emergency stop limit switch operated. Check the product.</td>
</tr>
<tr>
<td>3</td>
<td>Product limit switch does not operate. Check for presence/absence of the product.</td>
</tr>
<tr>
<td>4</td>
<td>Hydraulic pressure of finishing machine 1 is low. Supply hydraulic oil.</td>
</tr>
</tbody>
</table>

1 Double-click [Comment] on the tree in the project workspace.

2 As the dialog box is displayed, register a comment.

3 After registering the comment, click (New Comment).
Register the second comment. After that, register the third and fourth comments in the same procedure.

When comment creation is completed, click the **Close** button.

### 2 Alarm List (User Alarm) setting method

1. Click **Alarm List**.

2. As the mouse cursor turns into +, click the mouse in the desired position to arrange the alarm list.

(From previous page)
As double-clicking the arranged alarm list displays the dialog box, make settings. (See below.)

Set data Basic tab
Alarm (Device) Points: 4

Set data Device tab
Device No.: Continuous
Alarm Device: M0

After setting is complete, click the OK button.

Adjust the size.

This completes the setting of the alarm list (user alarm).

Object set in this section
7.5 Saving the Created Monitor Data

How to save the created monitor data is explained in this section.

1. Select the [Project] → [Save As].

2. As the dialog box is displayed, select the storage location and set the file name.

3. Click the [Save] button to save the monitor data.
8. EXECUTING MONITOR ON THE GOT

This chapter explains how to transfer the monitor data, which was created on GT Designer2, to the GOT and display them. This manual uses the A975GOT in the example for explanation.

8.1 Transferring Monitor Data from Personal Computer to GOT

This section explains how to transfer the monitor screen data from the personal computer to the GOT.

8.1.1 Connecting the personal computer and GOT

Connect the personal computer and GOT.

IBM-PC/AT-compatible personal computer

AC30R2-9SS or
FX-232CAB-1

To RS-232C connector

To RS-232C connector

GOT

To shorten data transfer time

A PC card can also be used to transfer the monitor data. When the PC card is used, work time can be shortened since the data transfer speed is higher than RS-232C communication speed. *1

Refer to the following manual for data transfer using the PC card.

GT Designer2 Version1 Operating Manual

*1 Reference value: In the case of screen data (589,572 bytes (30 screens)), PC card: approx. 55 seconds, RS-232C communication: approx. 5 minutes
8.1.2 Installing the OS and communication driver

The GOT does not include the OS for monitoring and the driver for communication with the PLC CPU. Hence, this installation operation must be performed only once before starting monitoring. This operation is required again when the OS is updated or the method of communication with the PLC is changed.

Point

Precautions for installation of OS

Installing the OS into the GOT erases the monitor data in the GOT. When the data in the GOT is necessary, upload them. (Section 8.3 Uploading)

1. Select the [Communication] -> [To/From GOT].

2. As the dialog box is displayed, select the Communication Configuration tab.

3. On the Communication Configuration tab, confirm and set the communication setting of the used personal computer. After setting, select the OS install -> GOT tab.
On the OS install -> GOT tab, select the standard monitor OS, communication driver and extended function OS to be installed into the GOT.

The following OSs are selected in this manual.

- Standard monitor OS: English
- Communication driver: Bus connection (Q)
- Extended function OS: Not installed.
- GOT type: A985GOT/A97, A960GOT

After making selection, click the Install button to start the installation of the OS and communication driver.

After OS installation is completed, reset the GOT.

8.1.3 Downloading the monitor data

After OS installation, download the created monitor data to the GOT.

Select the Download -> GOT tab.

On the Download -> GOT tab, select the data (base screen, window screen, common settings) to be downloaded to the GOT.

- Project configuration tree: Check all.

After making selection, click the Download button to start the downloading of the monitor data.
8.2 Connecting with the PLC CPU

After transferring the OS, communication driver and monitor screen data to the GOT, connect the GOT and PLC CPU. This manual explains this connection in an example of bus-connecting the A975GOT and QCPU.

System configuration example

![Diagram of system configuration example]

*1 For the system configuration, usage, etc. of GX Developer, refer to the GX Developer Operating Manual.

**Point**

Precautions for bus connection

Refer to the following manual for the precautions for bus connection.


Connecting the communication board to the GOT

Mount the bus connection board to the communication board slot of the GOT. Mount the bus connection board with the GOT powered OFF. Refer to the following manual for the communication board mounting method.

![Diagram of connecting the communication board to the GOT]

A985GOT/A975GOT/A970GOT/A960GOT User's Manual
2 Setting the extension stage number and I/O slot No. of the GOT
When bus connection is made, the extension stage number and I/O slot No. of the GOT must be set in [Setup] of the GOT utility.
For details of the utility, refer to the following manual.


Select "Setup" of utility.

QBUS extension stage number: Set to "1".
QBUS slot No. : Set to "0".
In this example, set the QBUS extension stage number to "1".

3 Connecting to the PLC CPU
Connect the GOT and PLC CPU with the bus connection cable.
Before connecting the GOT to the PLC CPU, always power off the whole system.
Refer to the following manual for details of the system configuration for connection.


In this example, connect to the main base.
Sequence program used in this section
5 Operation image on GOT

Base screen 1

The D10 value is displayed.

When any of M0 to M3 is turned ON with GX Developer, etc., the corresponding lamp is lit.

If an error occurs in the GOT or CPU, the error code and error message are displayed.

Touching here switches the display to Base screen 2.

Touching here displays the key window and inputs the value to D11.

Touching the switch turns OFF the corresponding one of M0 to M3 that is ON (extinguishes the lamp).

Touching here switches the display to Base screen 2.

Base screen 2

Comments of M0 to M3 that are ON on Base screen 1 are displayed.

Touching here switches the display to Base screen 1.
8.3 Uploading

When it is desired to back up or correct the monitor data that has been downloaded to the GOT, upload the monitor data to the personal computer.

1. Select the [Communication] → [To/From GOT].

2. As the dialog box is displayed, select the Upload -> Computer tab.
   - Upload path: GT Designer2

3. Click the [Upload] button to execute uploading.
**WARRANTY**

Please confirm the following product warranty details before using this product.

1. **Gratis Warranty Term and Gratis Warranty Range**
   If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty term, the product shall be repaired at no cost via the sales representative or Mitsubishi Service Company.
   However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will be solely at the customer’s discretion. Mitsubishi shall not be held responsible for any re-commissioning, maintenance, or testing on-site that involves replacement of the failed module.

   **[Gratis Warranty Term]**
   The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated place.
   Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair parts shall not exceed the gratis warranty term before repairs.

   **[Gratis Warranty Range]**
   (1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the product.
   (2) Even within the gratis warranty term, repairs shall be charged for in the following cases.
   1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused by the user's hardware or software design.
   2. Failure caused by unapproved modifications, etc., to the product by the user.
   3. When the Mitsubishi product is assembled into a user's device. Failure that could have been avoided if functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary by industry standards, had been provided.
   4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the instruction manual had been correctly serviced or replaced.
   5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force majeure such as earthquakes, lightening, wind and water damage.
   6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi.
   7. Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the user.

2. **Onerous repair term after discontinuation of production**
   (1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued.
   Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc.
   (2) Product supply (including repair parts) is not available after production is discontinued.

3. **Overseas service**
   Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA Center may differ.

4. **Exclusion of loss in opportunity and secondary loss from warranty liability**
   Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation of damages caused by any cause found not to be the responsibility of Mitsubishi, loss in opportunity, lost profits incurred to the user by Failures of Mitsubishi products, special damages and secondary damages whether foreseeable or not, compensation for accidents, and compensation for damages to products other than Mitsubishi products, replacement by the user, maintenance of on-site equipment, start-up test run and other tasks.

5. **Changes in product specifications**
   The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.

6. **Product application**
   (1) In using the Mitsubishi MELSEC programmable logic controller, the usage conditions shall be that the application will not lead to a major accident even if any problem or fault should occur in the programmable logic controller device, and that backup and fail-safe functions are systematically provided outside of the device for any problem or fault.
   (2) The Mitsubishi programmable logic controller has been designed and manufactured for applications in general industries, etc. Thus, applications in which the public could be affected such as in nuclear power plants and other power plants operated by respective power companies, and applications in which a special quality assurance system is required, such as for Railway companies or Public service purposes shall be excluded from the programmable logic controller applications.
   In addition, applications in which human life or property that could be greatly affected, such as in aircraft, medical applications, incineration and fuel devices, manned transportation, equipment for recreation and amusement, and safety devices, shall also be excluded from the programmable logic controller range of applications. However, in certain cases, some applications may be possible, providing the user consults their local Mitsubishi representative outlining the special requirements of the project, and providing that all parties concerned agree to the special circumstances, solely at the users discretion.
Specifications subject to change without notice.

When exported from Japan, this manual does not require application to the Ministry of Economy, Trade and Industry for service transaction permission.